Field Manual
For forest vegetation and fuels monitoring in the southern Blues CFLRP area

Blue Mountains Forest Partners
Oregon State University

Revised October 15, 2015
Table of Contents

1. Introduction p. 3

2. Locate and monument plots 5
   2.1 Locate plot center and mark with metal pin and flagging 5
   2.2 Select a monument tree and install monument marker 5
   2.3 Replace metal pins and flagging and relocate plot center as necessary 5

3. Measure understory composition 6
   3.1 Locate transects 6
   3.2 Record canopy intercepts 6
   3.3 Record surface intercepts 7

4. Measure forb, herb, and shrub fuel loading 8
   4.1 Locate microplots 8
   4.2 Compare visual observations of forbs, herbs, and shrubs fuels to photoload sequences 9

5. Measure surface fuels 9
   5.1 Review rules for recording surface fuels 10
   5.2 Measure 1-, 10-, 100- and 1,000-hour fuels along the transects 10
   5.3 Measure duff and litter depth 11

6. Measure live and dead trees 12
   6.1 Review tree measurement rules 12
   6.2 Measure large plot (58.4 foot radius) live and dead trees 14
   6.3 Measure inner plot (37.1 foot radius) live trees 14
   6.4 Measure subplot (11.8 foot radius) plot live trees 15

7. Photo-document plots 14

8. Fill out data sheets or touchpad fields 15

9. References 17

10. Appendices 18
    10.1 Pre-field ArcMap 10.2.2 procedures 18
    10.2 Equipment and materials checklist 19
    10.3 Random azimuths 20
    10.4 Notes 21
1. Introduction

Forest vegetation and fuels (FVF) monitoring within the southern Blues Collaborative Forest Landscape Restoration Program area involves collecting data about forest stand characteristics both before and after treatment and among treated and untreated stands. Four basic types of data are collected: 1) Overstory tree structure and composition, 2) understory vegetation cover, 3) surface fuels, and 4) repeat photography.

*Figure 1. FVF plot design.*

Data is collected in fixed-area nested circular plots located at the intersection of gridlines overlaid on randomly selected units. The minimum size of randomly selected treated and untreated units is 0.5 acres. The width of the grid will vary by unit size so that there will be no less than 2 and no more than 25 plots per unit.

Plot design is shown in Figure 1. Each plot consists of:

- One 0.25-acre outer plot
- One 0.1-acre inner plot
- One 0.01-acre subplot plot randomly located more than 12’ and less than 25’ from plot center.
- Two 60’ transects—the first located on a random azimuth and the second transect located at a 90˚ angle to the first transect.
- Two 1m² microplots located to the side of each transect 30 feet from plot center.
Large (≥20” dbh) live and dead tree structure and composition data is collected in the 0.25-acre outer plot. Small to large (≥4” dbh) live and dead tree structure and composition data is collected in the 0.1-acre inner plot. Seedling data is collected in the 0.01-acre subplot. Table 1 summarizes plot dimensions and data collection within each nested plot.

1-, 10-, 100- and 1,000-hour surface fuels are measured using a modified Brown’s planar intercept method along the two 60’ long transects (Brown 1974). Duff and litter depths are measured at three points along each transect. Live shrub, herb (including grass), and forb fuels are estimated using the photoload sampling technique in the two 1m² microplots (Keane and Dickinson 2007). Understory species composition is recorded using the point intercept method at 25 points each along the outer 50’ of both transects (Herrick et al. 2005). Four permanent photo points are established in each plot by taking a wide-angle photo centered on a fixed point facing outward from plot center in each cardinal direction.

<table>
<thead>
<tr>
<th>Plot</th>
<th>Vegetation</th>
<th>Measurement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outer plot</td>
<td>Live trees ≥20” DBH</td>
<td>- Species&lt;br&gt;- DBH&lt;br&gt;- Height&lt;br&gt;- Height to fine fuel&lt;br&gt;- Crown class</td>
</tr>
<tr>
<td>58’ 5” radius</td>
<td></td>
<td>Snags ≥20” DBH</td>
</tr>
<tr>
<td>(17.8m radius)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>.25 ac (.1 ha)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inner plot</td>
<td>Live trees ≥4” DBH</td>
<td>- Species&lt;br&gt;- DBH&lt;br&gt;- Height&lt;br&gt;- Height to fine fuel&lt;br&gt;- Crown class</td>
</tr>
<tr>
<td>37’ 1” radius</td>
<td></td>
<td>Snags ≥4” DBH</td>
</tr>
<tr>
<td>(11.3m radius)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>.1 ac (.04 ha)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subplot</td>
<td>Live trees ≥2” DBH</td>
<td>- Species&lt;br&gt;- DBH&lt;br&gt;- Height&lt;br&gt;- Height to fine fuel&lt;br&gt;- Crown class</td>
</tr>
<tr>
<td>11’ 10” radius</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(3.6m radius)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>.01 ac (.004 ha)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Live seedlings and saplings ≤2” DBH and ≥6” tall</td>
<td>- Tally by species in four height bins</td>
</tr>
</tbody>
</table>

This document is a how-to guide. You can follow the directions below more or less in order to gather the data required by the FVF Monitoring Plan.
2. Locate and monument plots

2.1 Locate plot center and mark with metal pin and flagging

Use a handheld GPS device to locate plot center coordinates. Our goal is to locate plot center within 2 meters of the coordinates you are given. However, GPS coordinates read off a handheld device tend to “float” somewhat. When you record plot center coordinates on data sheets or handheld touchpads, make sure that you record the GPS coordinates read from your handheld device, not the coordinates you were given before you went into the field.

Do not locate a plot if portions of the plot fall in an area that poses a hazard to crews or installing permanent plots significantly interferes with other lawful uses of the forest (e.g., recreation facilities or stock developments). If a plot center or more than half of the total nested circular plot area falls outside a unit area boundary, do not locate that plot. If part of a plot falls outside a unit area boundary but plot center and at least half of the total nested circular plot area falls inside a unit area boundary, you will measure exactly half of the plot that is located within the unit. Locate the two transects and subplot in the half of the plot to be measured. These procedures are designed to ensure that every part of a unit, including areas near the edge of a unit, have a roughly equal probability of being sampled.

All plots are monumented to allow relocation of plot center after timber harvest activities. The main goal in monumenting plots is to make it possible to relocate them without significant effort. A secondary goal is to make plot locations somewhat innocuous so as not to interfere with logging operations—we are monitoring the change that results from logging operations and we want plots to be representative of the logging unit we’re measuring. Use your best judgment in balancing these competing goals.

Once you have located plot center within 2 meters of the provided coordinates, insert a metal stake into the ground so the rounded top of the stake is flush with the ground. Paint the stake with orange paint. Tie a ribbon around the stake and write the plot ID, the date, and the initials of the crew on the ribbon.

2.2 Select a monument tree and install monument marker

To aid in relocating the plot center, identify the largest live, healthy tree between 60 and 100 feet from plot center. Nail a small metal plaque with the date, your initials, the plot ID, and the exact distance and bearing to plot center on the flagging. Tie flagging around the tree. Record the UTM coordinates of each tree, along with the species, DBH, estimated height, and a brief description of the tree on your data sheet.

2.3 Replace metal pins and flagging and relocate plot center as necessary

If you are revisiting a previously installed plot, it may be necessary to replace faded flagging on monument trees and scorched, bent or otherwise damaged center plot stakes. If it is impossible to locate plot center stakes after a thorough search, reinstall the plot center using the information on monument trees, the most accurate GPS reading possible, and, most importantly, plot photos. You should be able to determine the exact center of the plot by matching the view through the camera lens with all four photos taken from plot center.
3. Measure understory composition

3.1 Locate transects

We are measuring the composition and spatial configuration of understory vegetation by recording plants and ground cover intercepted by a pin at 25 evenly separated points along the outer 50’ of the two 60’ transects. We are not measuring the inner 10’ because vegetation at plot center tends to be trampled, and you should take care when locating plots not to trample too much vegetation. The first transect (Transect A) extends along a random azimuth originating at plot center. The second transect (Transect B) also extends from plot center along an azimuth offset 90˚ E from the first transect (see Figure 1).

Anchor the zero end of your measuring tape at plot center, and run the tape out 60 feet along the selected azimuth and anchor with a metal pin. Secure flagging to the pin at the outer end of each transect and write your initials, the date, the plot number, and “TRAN A” or “TRAN B” on the flagging. The metal stake and flagging should remain in the ground after you’re done measuring the plot to aid in relocating transects when remeasuring plots. The tape should be taunt and as close to the ground as practical, which usually means threading the tape through any trees or brush along the correct azimuth (see Figure 2).

If a tree, large rock, or other obstacle blocks the path of the transect along the selected azimuth, run the transect to the obstacle and begin the transect again at the other side, estimating the cover for any point that would have been located where the transect runs through the obstacle. Example: If the transect encounters a large pile of activity fuel, end the transect at the beginning of the pile and begin running the transect again at the other end, estimating distances and bearings as best you can and recording “litter” as a surface code (see below) for the points that would have been located within the pile. You should run the transect over rocks, stumps, snags or other obstacles less than waist height.

3.2 Record canopy intercepts

Begin at the 10’ mark on the tape and move towards the end of the tape, staying on the left hand side of the tape as you’re facing the end of the transect with your back to plot center. At every even two-foot mark on the tape (10’, 12’, 14’, etc.), place the pin on the ground on the right side of the tape. The pin should be touching the appropriate foot mark on the tape.
without moving the tape. Orient the pin so it is perpendicular to the ground (straight up and down), forming a cross with the tape like this: +.

Beginning at a point on the pin 3.28 feet (1m) from the ground, record a top canopy code for the first live or rooted dead plant that is touching the pin (an understory canopy intercept). Moving down the pin toward the ground, record lower canopy intercept codes for up to three additional live or rooted dead plant species that are touching the pin below the top canopy intercept.

Don’t record any vegetation as a canopy intercept that is more than 3.28’ above the ground. Live or rooted dead plants touching the pin should be recorded as canopy intercepts. If a plant is not rooted in the ground, do not record it. Only record a canopy code if that species has not already been recorded for that point (i.e., don’t record the same species twice at any point). Record “none” in the lower canopy layers if there are no unique species encountered below the top canopy species. Record “none” for the top canopy and lower canopy if no plants are touching the pin below 3.28’.

Record plant species as the NRCS code derived from the first two letters of the genus and the first two letters of the species, sometimes with a numeric suffix, for example “CARO5” for Carex rossii (Ross’s sedge). If you cannot identify the species, record just the genus, for example “LU01” (lupine genus #1). Keep a species list of all plants encountered in the field and the code that they have been assigned. If you cannot identify the species or genus, record one of the following unknown codes:

- **UKAG** Unknown annual grass
- **UKPG** Unknown perennial grass
- **UKSE** Unknown sedge or rush
- **UKHF** Unknown herb or forb
- **UKSH** Unknown shrub
- **UKIN** Unknown invasive

### 3.3 Record surface intercepts

As a final step, record whether the pin intercepts a plant base (see Figure 4) or one of the following in the surface column:

- **RO** = Rock
- **AS** = Ash (includes litter charred enough that it is not readily identifiable as litter)
- **LI** = Litter
- **DU** = Duff
- **WD** = Woody debris
- **MO** = Moss
- **LC** = Lichen crust on soil (lichen on rock is recorded as “RO”)
- **BG** = Bare ground/soil that is visibly unprotected by any of the above
- **WA** = Year round water, as in a stream (if you suspect it is a ephemeral stream, record another code).

For unidentified plant bases, use the procedure for unknown plants above. A stump is a plant base. If the plant base encountered is the same species as a species encountered as a canopy intercept, record that species as the plant base and delete it as a canopy intercept.
Litter for the purposes of point-intercept data collection includes all dead stems, leaves, and cones that are resting on the soil surface. Record litter only as a surface code. Do not record litter suspended in the air or leaning against a plant.

Refer to Figure 3 to help interpret point intercept procedures.

If you cannot observe the surface, for instance because you’re standing in activity fuel, use your best judgment to estimate the surface code (the surface code for a pile of activity fuel is likely to be litter) or record as “UK” (unknown).

If you intercept a garbage (e.g., a beer can), animal remains, or other object for which there’s no code, record “other.”

*Figure 3. Recording canopy and surface intercepts with the point intercept method.*

4. Measure forb, herb, and shrub fuel loading

4.1 Locate microplots
We will record fuel loadings of forbs, herbs and shrubs by comparing our visual estimates of these plants in 1m² microplots to a series of downward looking photographs.

Note: We distinguish between herbs and grasses while measuring understory vegetation using the point intercept method, but we combine herbs and grasses for the purposes of measuring forb, herb, and shrub fuels.

The top of the 1m² PVC microplot should be flush with the 30’ mark of each transect, located on the right side of the tape as you face outward with your back to plot center. Insert a metal stake or pin into the corner of the microplot nearest the transect and plot center and tie a piece of flagging around the stake. Write your initials, the date, the plot number, and “A MICRO” or “B MICRO” (depending on which transect it is located along) on the flagging. The stake or pin will remain in the ground after you finish measuring the plot to help relocate microplots when plots are re-measured.

4.2 Compare visual observations of forbs, herbs, and shrubs fuels to photoload sequences

Shrubs are woody plants that branch below or near ground level into several main stems, and have no clear trunk. They may be deciduous or evergreen, and at the end of each growing season there is no die-back of the axes. Herbs, which for this estimate includes grasses and sedges, are small, nonwoody, seed-bearing plants whose aerial parts die back at the end of each growing season. Forbs are broad-leaved herbs.

The first step in estimating forb, herb and shrub loadings with the photoload technique is to match the group of species occurring in the microplot with one or more of the photoload sequences. In most cases, the shrub or herb species in your microplot are not represented in the photoload sequences. Match the morphology of the species observed in the microplot with one of the seven shrub species, two grass species, and two forb species shown in the photoload sequences. Select the correct loading photo within the sequence based on two additional characteristics: cover and density. If there are several species of vegetation in your microplot you may choose to use a photoload sequence for each species and sum the individual loadings to make a final loading estimate of shrub or herbaceous components, or you can rate the loading as a collection of species using the most similar photoload sequence.

Note: Match grasses based on species, cover, and density regardless of whether vegetative material in the field is live or dead (only dead material is shown in the photoload sequences).

Use a ruler or a tape measure to measure and record the average height of shrubs and forbs in the microplots.

Write the plot number and “MICRO A” or “MICRO B” on the white board and photograph the microplot from a downward looking perspective.

5. Measure surface fuels

5.1 Review rules for recording surface fuels
We are measuring 1-, 10-, 100-, and 1,000-hour down woody fuel along the two transects.

1-hour fuels are <¼” in diameter.  
10-hour fuels are between ¼ – 1” in diameter.  
100-hour fuels are 1-3” in diameter.  
1,000-hour fuels are >3” in diameter.

Use your go-no-go gauge to differentiate among fuels in each of these classes.

All 1-, 10-, and 100- hour fuels measured must be down, dead, and woody.

*Down* – Down fuels are those fuel components that are not attached to live or upright dead plants and are on the ground or below six feet above the ground. All woody fuel originating from a tree bole is considered down woody if it leans at an angle less than 45 degrees from the surface. If it is at an angle greater than 45 degrees above horizontal, it can only be considered down if it is a broken bole or branch from a tree where at least one end of the bole is touching the ground (not supported by its own vegetation or other branches).

*Dead* – fuels that have no live foliage or branchwood material. Fresh slash and newly broken branches with green foliage are considered dead even though they are technically alive because they will soon be dead. Dormant plants with no live foliage, such as shrubs that lose their leaves in autumn do not count as dead fuel.

*Woody* – Many people are confused by woody fuel identification and tend to put stalks of annual plants into the woody category when in fact the stalks are dead herbaceous.

We also need to distinguish down, dead, and woody material from needles, detached grass blades, pine cones, and pieces of bark on the ground. This is considered duff or litter and is not included in the 1-1,000 hour fuel measurements. Dead ponderosa pine needles are often mistaken for down, dead, and woody, but they are duff or litter, which is measured in a final step.

**5.2 Measure 1-, 10-, 100- and 1,000-hour fuels along the transects**
We will be measuring all 1- and 10-hour fuels encountered between the 10’ and 16’ marks along each transect, all 100-hour fuels encountered between the 10’ and 22’ marks, and all 1,000-hour fuels encountered between the 0’ and 50’ marks.

Walk along the transect between the appropriate points and keep a simple tally of the number of down woody particles in the 1-, 10-, and 100-hour fuel categories that intersect the tape (see Figure 5). Also tally any particles that intercept an imaginary plane extending 6 feet above the tape and down to the surface. When using the go-no-go gauge to determine the fuel category, measure the particle at the point at which it intercepts the tape.

When a 1,000-hour piece of down woody fuel is encountered, measure the diameter of the piece perpendicular to the central axis of the piece where it intercepts the tape (see Figure 5). When measuring rotten logs, measure a visually reconstructed log diameter that reflects the existing wood mass, not the original sound diameter.

Do not measure 1,000-hour fuel pieces whose central axis is below the duff horizon (see Figure 6).

### 5.3 Measure duff and litter depth

At the 12’, 24’ and 36’ foot marks along each transect, insert a small shovel or knife into the ground until you hit mineral soil, and carefully pull away material exposing the litter/duff profile. Locate the boundary between the litter and duff layer. Record a vertical measurement of both the litter and duff layers. Litter is the surface layer of the forest floor that is not in an advanced stage of decomposition, usually primarily composed of recently fallen needles, stems, twigs, bark and fruits. Duff is the partially decomposed organic material of the forest floor beneath the litter (see Figure 7). Do not include twigs and larger stems in your measurements.

If the 12’, 24’, or 36’ marks are occupied by a tree, log, rock or other obstruction that does not permit excavation with your shovel, record both duff and litter measurements as “0.”

If the ground where the litter and duff
measurement is to take place is obscured by activity fuel, record the litter measurement as the total height of the activity fuel. If you cannot reach the surface to record a duff measurement, record the average of the closest two duff measurements for that point.

6. Measure live and dead trees

6.1 Review tree measurement rules

A tree is inside the plot and should be measured if more than half its bole at breast height is within the plot.

Use flagging and/or assign each tree a unique number to keep track of trees you’ve already measured if necessary.

Record height as the distance from the ground to the top of the tree, excluding any dead (“spike”) tops.

Record height to fine fuel as the distance from the ground to whichever is closer to the ground: 1) live or dead needles, or 2) fine dead fuel sufficient to carry a fire into the crown, usually dense, fine dead branches less than 2mm in diameter that are in contact with live or dead needles.

Table 2. Leaning tree height correction chart.

<table>
<thead>
<tr>
<th>MSHT</th>
<th>5</th>
<th>10</th>
<th>15</th>
<th>20</th>
<th>25</th>
<th>30</th>
<th>35</th>
<th>40</th>
<th>45</th>
<th>50</th>
<th>55</th>
<th>60</th>
<th>65</th>
<th>70</th>
<th>75</th>
<th>80</th>
<th>85</th>
<th>90</th>
</tr>
</thead>
<tbody>
<tr>
<td>40</td>
<td>40</td>
<td>41</td>
<td>43</td>
<td>45</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td>50</td>
<td>51</td>
<td>52</td>
<td>54</td>
<td>56</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>60</td>
<td>60</td>
<td>61</td>
<td>62</td>
<td>63</td>
<td>65</td>
<td>67</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>70</td>
<td>71</td>
<td>72</td>
<td>73</td>
<td>74</td>
<td>76</td>
<td>78</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>80</td>
<td>81</td>
<td>81</td>
<td>82</td>
<td>84</td>
<td>86</td>
<td>87</td>
<td>89</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>90</td>
<td>91</td>
<td>91</td>
<td>92</td>
<td>94</td>
<td>95</td>
<td>97</td>
<td>98</td>
<td>101</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100</td>
<td>101</td>
<td>101</td>
<td>102</td>
<td>103</td>
<td>104</td>
<td>106</td>
<td>108</td>
<td>110</td>
<td>112</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>111</td>
<td>112</td>
<td>113</td>
<td>114</td>
<td>116</td>
<td>117</td>
<td>119</td>
<td>121</td>
<td>123</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>120</td>
<td>121</td>
<td>122</td>
<td>123</td>
<td>124</td>
<td>125</td>
<td>126</td>
<td>128</td>
<td>130</td>
<td>132</td>
<td>134</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>130</td>
<td>131</td>
<td>131</td>
<td>132</td>
<td>133</td>
<td>135</td>
<td>136</td>
<td>138</td>
<td>139</td>
<td>141</td>
<td>143</td>
<td>145</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>140</td>
<td>141</td>
<td>141</td>
<td>142</td>
<td>143</td>
<td>144</td>
<td>146</td>
<td>147</td>
<td>149</td>
<td>150</td>
<td>152</td>
<td>154</td>
<td>157</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>150</td>
<td>151</td>
<td>151</td>
<td>152</td>
<td>153</td>
<td>154</td>
<td>155</td>
<td>157</td>
<td>158</td>
<td>160</td>
<td>162</td>
<td>164</td>
<td>166</td>
<td>168</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>160</td>
<td>161</td>
<td>161</td>
<td>162</td>
<td>163</td>
<td>164</td>
<td>165</td>
<td>166</td>
<td>168</td>
<td>169</td>
<td>171</td>
<td>173</td>
<td>175</td>
<td>177</td>
<td>179</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>170</td>
<td>171</td>
<td>171</td>
<td>172</td>
<td>173</td>
<td>174</td>
<td>175</td>
<td>176</td>
<td>177</td>
<td>179</td>
<td>1801</td>
<td>182</td>
<td>184</td>
<td>186</td>
<td>188</td>
<td>190</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>180</td>
<td>181</td>
<td>181</td>
<td>182</td>
<td>183</td>
<td>184</td>
<td>186</td>
<td>187</td>
<td>188</td>
<td>190</td>
<td>191</td>
<td>193</td>
<td>195</td>
<td>197</td>
<td>199</td>
<td>201</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>190</td>
<td>191</td>
<td>192</td>
<td>192</td>
<td>193</td>
<td>194</td>
<td>195</td>
<td>196</td>
<td>198</td>
<td>200</td>
<td>201</td>
<td>203</td>
<td>204</td>
<td>206</td>
<td>208</td>
<td>210</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>200</td>
<td>201</td>
<td>202</td>
<td>202</td>
<td>203</td>
<td>204</td>
<td>205</td>
<td>206</td>
<td>208</td>
<td>209</td>
<td>211</td>
<td>212</td>
<td>214</td>
<td>215</td>
<td>217</td>
<td>219</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

MS HT = (A B) Measured height
Sometimes it is difficult to see the top of a small tree because it’s surrounded by other tree tops. If one person shakes the tree, the top will move and make it visible to another observer.

Trees leaning 25% (about 15° from vertical) require a height correction. Measure the distance between the top of the tree and the ground (A to B in Figure 9). Then measure the horizontal distance between the tree trunk and the top of the tree (B to C) and use the correction from Table 2.

Crown class is a description of the relative position of the tree crown with respect to competing vegetation surrounding the tree. In assigning one of the following crown class codes, classify each tree based on its immediate environment. Base your classification on how much light the tree’s crown is receiving, not its position in the canopy. The intermediate and overtopped crown classes are meant to include trees seriously affected by direct competition with adjacent trees. For example, a young vigorous tree that is considerably shorter than other trees in the stand but not overtopped by other trees, and receives full light from above and partly from the side is classified as dominant. Use the codes for crown class from Table 3 and refer to Figure 8.

**Table 3. Crown class codes**

<table>
<thead>
<tr>
<th>Code</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OP</td>
<td>Open-grown or Isolated</td>
<td>Tree crowns receive full light from above and from all sides. In even-aged stands, these trees have their crowns well above the general canopy.</td>
</tr>
<tr>
<td>DO</td>
<td>Dominant</td>
<td>Tree crowns receive full light from above and partly from the sides. Crowns extend above the general level of the crown cover of others of the same stratum and are not physically restricted from above, although possibly somewhat crowded by other trees on the sides. In even-aged stands, dominant trees rise somewhat above the general canopy.</td>
</tr>
<tr>
<td>CO</td>
<td>Codominant</td>
<td>Tree crowns receive full light from above, but comparatively little from the sides. Crowns form a general level of crown stratum, are not physically restricted from above and are crowded by other trees from the sides. In even-aged stands, codominants form the general canopy level.</td>
</tr>
<tr>
<td>IN</td>
<td>Intermediate</td>
<td>Tree crowns occupy a definitely subordinate position and are subject to strong lateral competition from crowns of dominants and codominants. They receive little direct light from above through small holes in the canopy, but no light from the sides.</td>
</tr>
<tr>
<td>OV</td>
<td>Overtopped</td>
<td>Tree crowns receive no direct light from above or from the sides and are entirely below the general level of dominant and codominant trees.</td>
</tr>
</tbody>
</table>
Remnant Trees that remain from a previous management activity or catastrophic event. The tree is significantly older than the surrounding vegetation. Remnant trees do not form a canopy layer and are usually isolated individuals or small clumps. This definition is from the Region 6 Inventory and Monitoring System field procedures for the Current Vegetation Survey.

Leader Above Brush The terminal leader of the tree is above the surrounding brush while the middle or lower crown may be within the brush canopy.

Leader Within Brush The terminal leader and upper crown of the tree is within the brush canopy.

Leader Overtopped by Brush The crown of the tree is completely overtopped by surrounding brush. This cover crown class only applies to isolated or dominant trees with. Competition from adjacent trees is more important than competition from shrubs if they both occur. Brush cover crown codes are used in stands where overstory tree competition is absent.

A tree is alive if it has any live foliage on it whatsoever, even if you’re certain it will die soon. Use the decay class codes from Table 4.

### Table 4. Decay class codes

<table>
<thead>
<tr>
<th>Decay class</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>All bark is intact. All but the smallest twigs are present. Old needles probably still present. Hard when kicked.</td>
</tr>
<tr>
<td>2</td>
<td>Some bark is missing, as are many of the smaller branches. No old needles still on branches. Hard when kicked.</td>
</tr>
<tr>
<td>3</td>
<td>Most of the bark is missing, and most of the branches less than 1 inch in diameter also missing. Still hard when kicked.</td>
</tr>
<tr>
<td>4</td>
<td>Looks like a class 3 snag but the sapwood is rotten. Sounds hollow when kicked, and you can probably remove wood from the outside of the bole with your boot.</td>
</tr>
<tr>
<td>5</td>
<td>Easy to kick apart. Only stumps are considered Class 5 snags. If a totally rotten snag is taller than 6 foot, it is a class 4 snag.</td>
</tr>
</tbody>
</table>

### 6.2 Measure large plot (58.4 foot radius) live and dead trees

Begin along a line extending due west from plot center to the outer edge of the large plot. Identify the first live or dead tree ≥ 20” DBH between the outer edge of the large plot and plot center and tie a piece of flagging to it. Move clockwise between the outer edge of the large plot and plot center; record the measurements below until you return to the first tree.

Species, DBH, height, height to fine fuel, and crown class of all live trees ≥20” DBH. Species, DBH, height, and decay class, of all dead trees ≥20” DBH and ≥4’ 5” tall.

### 6.3 Measure inner (37.1 foot radius) plot live trees

Begin along a line extending due west from inner plot center to the outer edge of the inner plot. Identify the first live or dead tree ≥ 4” DBH and tie a piece of flagging to it. Move
clockwise between the outer edge of the inner plot and plot center; record the measurements below until you return to the first tree.

Species, DBH, height, height to fine fuel, and crown class of all live trees ≥4” and <20” DBH. Species, DBH, height, decay class of all dead trees ≥4” but <20”DBH and ≥4’ 5” tall.

6.4 Measure subplot (11.8 foot radius) plot live trees

The center of the smallest tree plot is located along a random azimuth and random distance between 12’-37’ from main plot center. Extend the 11.8’ subplot radius from this randomly generated location.

Begin along a line extending due west from subplot center to the outer edge of the small plot. Move clockwise within the small center; record the measurements below until you return to the first tree.

Tally in eight height bins of trees <2” DBH. Species, DBH, height, height to fine fuel, and crown class of trees >2” DBH and <4” DBH.

7. Photo-document plots

Write the plot ID, crew initials, and the date on a whiteboard or notebook paper, photograph the whiteboard or paper, and then take four photos from plot center in each of the cardinal directions in this order: West, North, East, then South. For each photograph, insert a Robel pole into the ground exactly 37.1 feet from plot center. Make the exact center of the photograph a point one meter above the ground on the Robel pole.

Take wide-angle photos in landscape mode. Review the photo on-screen and replace your first effort if necessary. Use the maximum resolution and hold the camera as steady as possible to ensure a sharp photograph—these photo files will be permanently archived. All photos should be sharp, as evenly lit as lighting conditions allow, and not have any people or equipment other than the Robel pole in the frame.

8. Fill out data sheets or touchpad fields

Plot field: Plot IDs consist of a three letter planning area code, a three digit stand code, and a two digit plot number, e.g., "MDE.006.05" (Marshal Devine planning area, unit #6, plot #5). All plot IDs should have a total of three letters and five digits. When entering into a data base or spreadsheet keep the zeros, but remove all dashes, spaces or special characters. You can use dashes on the data sheets.

Date field: The date or dates when plot measurements took place

Crew field: The initials of everyone crew working on the plot. The first time someone works on the crew, record their entire name.

Datum field: Confirm that you are using the NAD83 datum.
UTM field: Record the UTMs of plot center from the GPS receiver on the data sheet, even if you’re using the pre-determined grid values.

Elevation field: Record the elevation in feet above sea level at plot center. Calibrate your GPS unit from a known elevation at the office in the morning and at other locations of known elevation during the day.

Aspect field: Record the predominant plot aspect in degrees, 0° to 360°. Record in true north (i.e., always set the declination on your compass). Aspect may be determined from contour maps. Flat ground is recorded as N/A. Declination for the MNF CFLRP area is 15° as of the date of this revision, but changes on an annual basis.

Slope field: Record the angle of slope across the plot. Slope is determined using the hypsometer set on “incline” mode. Slope is measured along the shortest pathway down slope before the drainage direction changes. If slope changes gradually across the plot, record an average slope. If slope changes across the plot but the slope is predominately of one direction, code predominate slope percentage rather than the average. If the slope falls directly between two side hills, code the average slope of the side hill(s). If the slope falls on a canyon bottom or on a narrow ridge top, but most of the area lies on one side hill, code the slope of the side hill.

Forest structure field: Record one of the following codes that best describe the overall structure of the forest within the largest plot. Structure is the distribution of tree size classes within the stand.

Table 5. Forest structure codes

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SS</td>
<td>Single story - A single even canopy characterizes the setting. The greatest number of trees is in a height class represented by the average height of the setting; there are substantially fewer trees in height classes above and below this mean.</td>
</tr>
<tr>
<td>TS</td>
<td>Two-storied - Two relatively even canopy levels can be recognized in the setting. The frequency distribution of trees by height class tends to be bimodal. Understory or overtopped trees are common. Neither canopy level is necessarily continuous or closed, but both canopy levels tend to be uniformly distributed across the setting (e.g., overstory with regenerated understory).</td>
</tr>
<tr>
<td>MS</td>
<td>Multi-storied - At least three height size classes are commonly represented in the setting. Generally, the canopy is broken and uneven although multiple canopy levels may be distinguishable. The various size classes tend to be uniformly distributed throughout the setting.</td>
</tr>
<tr>
<td>MO</td>
<td>Mosaic - At least two distinct height size classes are represented and these are not uniformly distributed, but are grouped in small repeating aggregations, or occur as stringers less than two chains wide, throughout the setting. Each size class aggregation is too small to be recognized and mapped as an individual setting.</td>
</tr>
<tr>
<td>UA</td>
<td>Unknown/un-assessable - A structure classification was attempted, but the stand did not fit into one of the pre-defined categories.</td>
</tr>
</tbody>
</table>
Total tree cover field: Record the estimated vertically projected percent canopy cover for all trees in the plot area as 10, 25, 50, or 75% (see Figure 11). This estimate includes cover of all tree species from the smallest of seedlings to the tallest of old growth stems. It includes all layers of canopy vertically projected to the ground. Vertically projected cover is best described as the cover of the sampling entity if it were compressed straight to the ground. Do not double count overlapping canopy foliage. For instance, in the right panels of figure 11, 40% of the plot area is covered by overlapping trees that may be of different heights and species.

Plant association field: Use Johnson and Clausnitzer (1992) to identify the predominant plant association of the plot.

Monument tree field: Record UTM coordinates of monument tree(s), species of tree(s), distance and bearing to plot center (not from plot center) along with a brief description of the tree.

Plot notes field: Record any important observations about the plot that were not recorded elsewhere. Examples include but are not limited to significant damage to trees, evidence of recent fire, firewood harvesting, or rarely seen wildlife.

If you encounter hazards (including but not limited to leaning snags, snakes, hornets, etc) write HAZARD at the top of the data sheet and record details in plot notes.

Recorded by and reviewed by fields: Indicate who recorded data and who reviewed each data sheet. The cards should be checked to make sure all entries are correct and legible, and there no blank entries.

Do not leave any part of any data sheet blank. If there is no data for a data sheet entry space, write “NA” or cross it out.

9. References


10. Appendices

10.1 Pre-field ArcMap 10.2.2 procedures

Step #1: Randomly select units
Create list of all unit numbers using the following (example) R code:

```r
#units <- c(1, 2, 3, 4, 5, 6, 7, 8, 9, 10)
#sample(units, 5) #second argument is number of selections
```

Step #2: Check ArcMap coordinates system

View → Data Frame Properties → Coordinate System

Should be NAD_1983_Oregon_Washington_Albers

Step #3: Select units

Select units identified by random selection procedure (see step #1).
Open attribute table. Select by attributes. Build statement including selected unit(s), e.g., “UNIT_NUMBE” = ‘5’.

Click on layer, select Data → Export Data. Click on folder icon, provide a new name (e.g. unit5), save as type Shapefile, and save.

Step #4: Overlay a grid on selected units

Data Management Tools → Feature Class → Create Fishnet.

Output feature class = name of your new layer, i.e., unit5_Plots.

Template extent = the selected unit, e.g., unit5.

Cell size width and cell size height are in the measurement units of unit_5 and should be symmetrical, for instance, cell size width = 170 and cell size height = 170.

Number of rows and number of columns should be 0.

Make sure the Create Label Points box is clicked.

Geometry type should be POLYLINE.

This will create TWO files: First, a rectangular grid (i.e., unit5_plots), and second, points which will serve as plot centers (i.e., unit5_plots_label).

Step #5: Clip the grid to the selected unit

Analysis Tools → Extract → Clip

Input Features: The plot points layer, i.e., unit5_plots_label.

Clip Features: The selected unit, i.e., unit5.

Step #6: Check the plot count

Check the size of the selected stand and count the plots to make sure it contains the minimum number of plots per area. Make sure that there are not too many plots (in general there should not be more than 15% more plots than the minimum plots per unit). Repeat from step #4 if necessary. Consult table 3 for approximate plot number targets.

Step #7: Add plot IDs and GPS coordinates to attribute table
Once you are satisfied with the number and arrangement of plots centers, the last step is to generate a unique identifier for each plot, generate coordinates, and create a map for use in the field.

To create an empty field to hold the coordinates, open the attribute table for the plot label shapefile. Click the table options button (top left) and hit "Add Field" and name it Plot_ID. Type should be "Text".

Right click on the heading of the "Plot_ID" field you just created and choose "Field Calculator". To create a plot ID that has the name of the project area, a unique identifier for the stand, and a unique identifier for each plot in the stand, type the following expression into the Plot_ID= dialog box:

"WLF.018."&"&[OBJECTID]

This will result in Plot IDs such as "WLF.18.1" (Wolf Project Area, Stand #18, Plot #1). Right click on the layer in the Table of Contents and click "Label Features" to display these IDs.

The next step is to generate UTM coordinates for these plots. First, make sure that the layer you are working in is displaying the right coordinate system. Right click on the Layers icon in the Table of Contents, go to Properties → Coordinate System and make sure you are using NAD_1983_Oregon_Washington_Albers. Then click on the General tab and click "UTM" under the Units → Display menu.

Open the attribute table of the plot shapefile. Click the table options button (top left) and hit "Add Field". Name it "x_coord". The type should be "Double". Click on the column header of this new column and select Calculate Geometry. Make the property "X Coordinate of Point," and make the units decimal degrees. Create a "y_coord" field and repeat the calculate geometry procedure this time to generate y coordinates.

Click the table options button (top left) and hit select all. Then click the black arrow on the top right row and hit copy selected. Paste into an Excel Spreadsheet.

Generate a map of the selected stand(s).

Table 6: Target plots per unit

<table>
<thead>
<tr>
<th>Unit size (acres)</th>
<th>Number of plots</th>
<th>Approximate grid spacing (meters)</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;10</td>
<td>2</td>
<td>160 x 160</td>
</tr>
<tr>
<td>10</td>
<td>2</td>
<td>170 x 170</td>
</tr>
<tr>
<td>20</td>
<td>3</td>
<td>170 x 170</td>
</tr>
<tr>
<td>30</td>
<td>4</td>
<td>170 x 170</td>
</tr>
<tr>
<td>40</td>
<td>5</td>
<td>180 x 180</td>
</tr>
<tr>
<td>50</td>
<td>6</td>
<td>180 x 180</td>
</tr>
<tr>
<td>60</td>
<td>7</td>
<td>180 x 180</td>
</tr>
<tr>
<td>70</td>
<td>8</td>
<td>180 x 180</td>
</tr>
<tr>
<td>80</td>
<td>9</td>
<td>190 x 190</td>
</tr>
<tr>
<td>90</td>
<td>10</td>
<td>190 x 190</td>
</tr>
<tr>
<td>100</td>
<td>11</td>
<td>190 x 190</td>
</tr>
<tr>
<td>110</td>
<td>12</td>
<td>190 x 190</td>
</tr>
<tr>
<td>120</td>
<td>13</td>
<td>190 x 190</td>
</tr>
<tr>
<td>130</td>
<td>14</td>
<td>190 x 190</td>
</tr>
<tr>
<td>140</td>
<td>15</td>
<td>200 x 200</td>
</tr>
<tr>
<td>150</td>
<td>16</td>
<td>200 x 200</td>
</tr>
<tr>
<td>175</td>
<td>19</td>
<td>200 x 200</td>
</tr>
<tr>
<td>200</td>
<td>21</td>
<td>200 x 200</td>
</tr>
<tr>
<td>250</td>
<td>25</td>
<td>200 x 200</td>
</tr>
<tr>
<td>250+</td>
<td>25</td>
<td>&gt;210 x 210</td>
</tr>
</tbody>
</table>
10.2 Equipment and materials checklist

Equipment
- Hypsometer x 2
- Digital camera x 2
- GPS unit x 2
- Robel pole x 2
- DBH tapes x 4
- 18” and 24” increment borer
- Flexible measuring tape (minimum 60’ length) x 4
- Hand lenses x 4
- Clear plastic rulers x 4
- Go-no-go gauges x 4
- Stiff metal or wood pin at least 3.5 feet in length and 1/8 inch in diameter x 4
- Radio
- First aid kit x 2
- 1m² PVC frames x 3
- Small shovel for litter and duff depth measurements x 4

Supplies
- Flagging
- Sharpies
- Pens
- Pencils
- Street chalk for marking trees
- List of randomly selected azimuths
- White board or blank unlined notebook for photopoints
- Short metal stakes pins for securing point intercept transect line and microplot corners
- Alligator clips for securing transects to plot center stake
- Laminated photoload sequence sheets
- Data sheets
- Spare batteries for GPS unit, camera, hypsometer
- Maps
- Garbage bags
- Emergency contact numbers
### 10.3 Random azimuths

<table>
<thead>
<tr>
<th>256</th>
<th>271</th>
<th>64</th>
<th>346</th>
<th>333</th>
<th>252</th>
<th>253</th>
<th>84</th>
<th>27</th>
<th>224</th>
</tr>
</thead>
<tbody>
<tr>
<td>321</td>
<td>256</td>
<td>239</td>
<td>215</td>
<td>75</td>
<td>69</td>
<td>15</td>
<td>131</td>
<td>18</td>
<td>346</td>
</tr>
<tr>
<td>133</td>
<td>216</td>
<td>82</td>
<td>53</td>
<td>155</td>
<td>170</td>
<td>208</td>
<td>351</td>
<td>288</td>
<td>64</td>
</tr>
<tr>
<td>225</td>
<td>333</td>
<td>131</td>
<td>281</td>
<td>298</td>
<td>229</td>
<td>209</td>
<td>93</td>
<td>58</td>
<td>197</td>
</tr>
<tr>
<td>14</td>
<td>141</td>
<td>209</td>
<td>311</td>
<td>144</td>
<td>325</td>
<td>14</td>
<td>321</td>
<td>206</td>
<td>104</td>
</tr>
<tr>
<td>2</td>
<td>335</td>
<td>143</td>
<td>25</td>
<td>65</td>
<td>229</td>
<td>287</td>
<td>355</td>
<td>212</td>
<td>170</td>
</tr>
<tr>
<td>156</td>
<td>64</td>
<td>151</td>
<td>286</td>
<td>258</td>
<td>193</td>
<td>238</td>
<td>183</td>
<td>27</td>
<td>122</td>
</tr>
<tr>
<td>207</td>
<td>89</td>
<td>231</td>
<td>84</td>
<td>261</td>
<td>306</td>
<td>210</td>
<td>125</td>
<td>210</td>
<td>80</td>
</tr>
<tr>
<td>60</td>
<td>293</td>
<td>355</td>
<td>237</td>
<td>129</td>
<td>155</td>
<td>288</td>
<td>205</td>
<td>110</td>
<td>65</td>
</tr>
<tr>
<td>334</td>
<td>352</td>
<td>63</td>
<td>254</td>
<td>62</td>
<td>56</td>
<td>317</td>
<td>84</td>
<td>12</td>
<td>57</td>
</tr>
<tr>
<td>300</td>
<td>41</td>
<td>352</td>
<td>39</td>
<td>53</td>
<td>38</td>
<td>82</td>
<td>180</td>
<td>110</td>
<td>292</td>
</tr>
<tr>
<td>201</td>
<td>100</td>
<td>180</td>
<td>222</td>
<td>39</td>
<td>124</td>
<td>298</td>
<td>205</td>
<td>44</td>
<td>245</td>
</tr>
<tr>
<td>334</td>
<td>286</td>
<td>129</td>
<td>70</td>
<td>280</td>
<td>78</td>
<td>301</td>
<td>59</td>
<td>109</td>
<td>344</td>
</tr>
</tbody>
</table>

### 10.4 Notes